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About the Klocwork packages and components
The Klocwork installation packages and components allow you to install only the components you need on
a specific machine.
Note: The Distributed Analysis package is covered separately in Installing the Distributed Analysis
package.

Server package components
Component

Details

License Server

A FlexNet Publisher license manager (command-line name: license). You
can also use your organization's FlexNet Publisher server. Default host:
localhost Default port: 27000 plus 33133

Klocwork Server

An Apache Tomcat Web server (command-line name: klocwork). Provides
access to Klocwork Static Code Analysis, Klocwork Code Review, and
Klocwork documentation. Klocwork clients connect to the Klocwork Server
for project information.
Note: Klocwork does not support using your own Apache Tomcat
server. You must use the Web server packaged with Klocwork.
Default host: localhost; default port: 8080 plus 8081.
The Klocwork Server component contains the Klocwork Database. Default
host: localhost; default port: 3306.

Projects root

The data location for the Klocwork Servers and applications, including
the project database tables, which are stored in MariaDB and Lucene
databases.
Note: The projects_root directory is not one of the components
you see listed in the installation wizard, but the wizard lets you
choose a location for it.
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Component

Details

Build tools

Integration build analysis tools:
•

•

tools for managing Klocwork projects, analysis, and access control
(kwadmin and kwbuildproject)
tools to produce a build specification (kwinject, kwwrap, kwant,
kwcsprojparser)
tools for running Klocwork integration build analysis (the analysis
engines)
sample projects

•
•
•

Klocwork Static Code Analysis
Klocwork Code Review
Klocwork Web API

•
•

GUI/web tools

Continuous Integration tools

Klocwork’s Continuous Integration (CI) capability enables your organization
to identify and communicate errors faster, without waiting for nightly
builds.
Klocwork’s CI tools integrate with third-party plug-ins and custom scripts
for CI environments so that developers can verify the quality of source
code as part of their pre-merge or post-commit processes.
Klocwork CI build analysis tools include the following:
•
•
•

tools to produce a build specification (kwinject, kwant, kwmaven,
kwwrap, kwcsprojparser, kwvcprojparser, kwmaven)
command-line analysis tools (kwciagent)
tools for running Klocwork CI build analysis (the analysis engines)

Desktop analysis components
Component

Details

Command Line Tools

Command-line versions of the Klocwork developer tools for C/C++, C#,
and Java, which allow software developers to verify the quality of source
code before they commit it to source control. Also includes Klocwork
Desktop, a GUI alternative to running kwcheck.
This component also includes the Klocwork Extensibility API for writing
custom checkers.

IDE Plug-ins

•
•
•
•

Klocwork Desktop plug-in for Visual Studio (Visual Studio extension)
Klocwork Desktop plug-in for Eclipse
Klocwork Desktop plug-in for IntelliJ IDEA
Klocwork Desktop plug-in for Android Studio

Note: Once deployed, users can download the desktop plug-in installers from within Klocwork. See
Installing a desktop analysis plug-in for more information.

4 | About the Klocwork packages and components | Klocwork

Upgrading from a previous version
Klocwork provides a simple way to import your existing Klocwork projects into a new projects_roots directory.
You can use the Klocwork portal GUI to connect to your existing Klocwork server then choose which projects
you'd like to import. If you're a Klocwork Code Review user, you can also connect to your existing server to
import your code reviews to Klocwork. The GUI enables a quick and painless migration to the very latest
version of Klocwork.
Klocwork also provides the ability to load builds from the previous major version of Klocwork into the current
version of Klocwork. For example, this means you can load Klocwork builds from any version of Klocwork
2019 through to 2019.3 into Klocwork 2020.3 without having to import or migrate data. For large organizations,
this feature provides flexibility by allowing you to upgrade the Server to take advantage of improvements,
while still analyzing some or all of your projects with a previous version of Klocwork. For more information,
see Cross-version support for builds.
We realize that no two installations are the same, and depending on your installation, you may choose to
migrate your projects root directory in its entirety. This method is still supported. Both methods are described
in detail in the sections below.

Import your existing projects into a new projects root
Klocwork includes a simple GUI that you can use to import projects from an existing projects_root to your
new Klocwork installation. This allows you to migrate your data on a project-by-project basis without using
the command line.
Before you decide to import your projects, make sure that your current installation supports this feature.
Typically, this process involves the following steps:
1. backing up your existing projects_root (just to be safe)
2. installing the new Klocwork Server (either on a new machine or using a different port number) and
starting the server.
3. validating your database
4. opening the portal, and using the GUI to import existing projects to the new installation
5. after testing your new installation, uninstalling the existing server and removing the old projects_root

Before you begin
The import process involves running your existing Klocwork installation (and projects_root) and your new
Klocwork installation (with clean projects_root) concurrently. Once you've installed the new server, you must
import any projects from the existing projects_root into the clean projects_root.
Remember that you cannot run two Klocwork servers on the same machine without specifying unique port
numbers. If you plan on installing the new Klocwork installation on the same machine, it's a good idea to stop
and restart your existing server using a different port number. This will allow you to maintain the existing
port number for your new installation.
If you are moving to a new major release of the software, ensure that you have a compatible license, as each
major release requires a new Klocwork license. See Licensing for more information.
Also, FlexNet Publisher prevents more than one instance of the vendor daemon from running on each machine,
which means that you cannot run two License Servers on one host. In this scenario, you need to run one
License Server and point both Klocwork installations to that License Server. See Licensing with multiple
projects_root directories for more information.
Both the Klocwork and Database servers require fully qualified domain names or IP addresses assigned in
order to be accessible from the target server host during the import process. Don't use localhost.
Note: You must have Projects root admin access in order to perform the import operation.
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Supported upgrade paths to versions of Klocwork that support project import
Find your current version in the chart below and follow the appropriate upgrade path. Once you've upgraded
to the correct version of Klocwork, you can import your existing projects from there.
The chart below is accurate for the latest current release. Rogue Wave is also here to help! If you need to
move from an older release, you can contact Static Code Analysis Professional Services to discuss assistance
via a services engagement.
If you're using Klocwork version

Then import is supported to the following version

2020.2 latest

Klocwork 2020.3 latest

2020.1 latest

Klocwork 2020.3 latest

2019.3 latest

Klocwork 2020.3 latest

2019.2 latest

Klocwork 2020.3 latest

2019.1 latest

Klocwork 2020.3 latest

2019 latest

Klocwork 2020.3 latest

2018.3 latest

Klocwork 2020.1 latest --> 2020.3 latest

Interoperability between releases
To take advantage of the latest improvements in Klocwork, we always recommend you upgrade your Server,
Build, and Desktop Analysis plug-ins to the latest version of the product. Klocwork Server and Build Tools are
compatible with the Desktop Analysis plug-ins within each major release.
Klocwork also provides the ability to load builds from the previous major version of Klocwork into the current
version of Klocwork. For example, this means you can load Klocwork builds from any version of Klocwork
2019 into Klocwork 2020.3 without having to import or migrate data. For more information, see Cross-version
support for builds.
If your current Klocwork server version does not meet the version requirements for importing projects,
upgrade your existing version of Klocwork to a supported service release or version. Next, install the latest
version of Klocwork. After you've installed the latest version of Klocwork, you can use it to connect to your
existing Klocwork server and import your projects. Follow the steps described below to import your projects.

Install the Klocwork Server package
Install the Klocwork 2020.3 Server package. For instructions, see Installing Klocwork.
Be sure to copy your license file to <projects_root>/licenses.
Note: See Licensing for information about options.

Start the server
Once you've installed the new version of Klocwork, start the servers. Each installation of Klocwork requires
you to specify a unique hostname and port number combination.
You can specify the unique hostname and port number combination either at startup, or during the installation
process. See, Managing the Klocwork Servers for more information.

Validate your database (mandatory)
dbvalidate is a tool that checks the consistency of data in your database. Running this tool is mandatory, so
that any errors in your database can be corrected before you migrate or import. Use the version of the
dbvalidate tool that matches your installed version of software (that is, the version that matches your
projects_root directory).
Note: The Database Server from your old installation must be running to validate the database. The
Database Server is listed as a separate service from the Klocwork Server, so ensure that it is running.

6 | Upgrading from a previous version | Klocwork

Run the following command, for example:
java -jar <server_install>/class/dbvalidate.jar --projects-root <projects_root>
where
•
•

<server_install> is your installation directory
<projects_root> specifies the location of the old projects root you want to validate

Example
java -jar /local/tools/klocwork/server/class/dbvalidate.jar --projects-root
/local/tools/klocwork/server/projects_root
The dbvalidate tool will report any errors between the "validation started" and "validation finished" lines:
Wed Jun 01 07:53:58 CDT 2018 kw_central database (version: 95) validation started
<detected errors appear here>
Wed Jun 01 07:54:28 CDT 2018 Database validation finished.
•
•

If Errors are displayed, please open a support ticket so that we can correct the error prior to import or
migration.
If no errors are displayed, your database was successfully validated.

You can also run dbvalidate with the --rebuildIndex=true option; This enables you to re-create the lucene
index for the specified project, which often allows you to decrease the size of the index.
Important: Make sure you back up your lucene index folder before running dbvalidate with the
--rebuildIndex=true option.
For example, you can run the following:
java -cp dbvalidate.jar com.klocwork.dbvalidate.Cleanup203 --projects-root
<projects_root_folder> --project <project_name> --rebuildIndex=true

Log in to Klocwork Static Code Analysis
After starting the Klocwork servers, Klocwork Static Code Analysis is accessible from a browser using the URL
of the Klocwork server hostname and the Klocwork server port chosen during the install (for example,
server21:8080). By default, the person who installed Klocwork is set as the Klocwork administrator, and is
given the Projects root admin role. Initially, the Basic Authentication access control method is used, so no
password is needed to log in. For example, if the user account used during the installation was ‘jsmith’, to log
in to Static Code Analysis with the administrator role, use the credentials:
username: jsmith
password: <empty>
For more details on security and authentication methods, see Security and permissions.

Import your projects and server settings
With the new Klocwork Server installed and the portal up and running, you can import server settings and
projects from your existing Klocwork installation.
When you import server settings from the existing source server, all global permission settings are imported
along with the permission settings for only those projects that exist on the destination server. In other words,
if you import Server A's settings to Server B, then you import a project from Server A to Server B, any permission
settings that are specific to project A will not be carried over to Server B. To carry forward project A's
project-specific permission settings, you must re-import the server settings after performing the import
operation.
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When importing server settings from a source Server A to target Server B, the following also applies:
•
•
•
•

Authentication settings from source Server A overwrite the authentication settings on target Server B.
For roles that exist on both servers, the role permissions for source Server A overwrite the role permissions
on target Server B.
Roles and their associated permissions that only existed on the source Server A are copied to the target
Server B.
Roles that only exist on target Server B are not modified; their permissions stay the same.
Important: In cases where a project contains custom settings, you must re-import your server
settings after performing a project import.

Note also that when importing a projects_root that contains a large number of issues and builds, your new
projects_root may increase in size.

Importing your existing projects
1. In the Klocwork portal, click Klocwork Static Code Analysis and log in to the product as the Projects root
admin user.
2. Click the Projects tab.
If this is your first time using the installation, click the Import settings or projects button.
If you've already created a project or imported a project, click the Import button.
3. In the Klocwork server connection dialog, specify the log in and connection information for your existing
Klocwork installation (the installation from which you want to import). Specify:
•
•
•

the URL of the existing server, for example: http://server21:8082
your user name. Note: you must have Projects root admin rights in order connect to the server and
import your projects.
your password (if required)

4. Click Import server configuration to import the existing server's configuration settings. This includes
authentication configuration settings, permissions, custom metrics, reports definitions, and e-mail
subscription settings.
Note: If you import authentication settings, the system may log you out as your credentials may no
longer be valid. If this happens, log in using the Admin credentials you just imported.
5. Click List Projects to see a list of projects in your existing projects_root.
6. In the Choose projects to import dialog, select the project(s) that you want to import to your new
projects_root.
7. Click Import. The Import status dialog will display the status of the project import, while an import status
message will appear at the top of the Projects tab.
Any project that imported successfully will appear in your projects list.
Note: During the import process, while projects are actively being imported, issue information
in the Projects view may not accurately reflect the data in the source project. Information in
the Projects view will be updated as soon as the import operation has completed. Check the
import status indicator for progress information.
8. Click Import server configuration again to import any project-specific configuration settings. This is a
mandatory step, since any project-specific configuration settings will be lost if you do not re-import the
server settings.
9. For each imported project, click Permissions and check that the permissions are correct for each project.
It is important to verify the permissions for each project since at import time. You should repeat this process
after each import operation, and you must be careful to re-import the server settings for each source server
that you import from.
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Note: If you are running Windows in a 32-bit environment and you previously modified the memory
allocation file located at <old_Klocwork_install>/config/java_wrappers_memory.conf,
verify that you still need those modifications and make the same changes to
java_wrappers_memory.conf in the new installation.

Use the Web API to import your projects
You can use the Klocwork Web API to import your projects on the command line. The Web API requires Web
API access permissions. By default, the Project admin role and the Projects root admin roles have access to
the Web API. The following example shows a curl script to import a given project:
curl --data "action=import_project&user=myself&project=my_project&sourceURL=
http://oldserver:8080&sourceAdmin=user&sourcePassword=pwd"
http://localhost.mycompany.com:8080/review/api
where:
•
•
•
•

project is the name of the project you want to import.
sourceURL is the URL of the existing, source Klocwork Server.
sourceAdmin is the user id of the source Klocwork Server administrator (must have Projects root admin
access).
sourcePassword is the administrator's password.

To return a list of all projects in the source projects_root folder, run the following command:
curl --data "action=projects&user=myself&"
http://localhost.mycompany.com:8080/review/api
You can also use the Web API to import your server configuration settings:
curl --data "action=import_server_configuration&user=myself&sourceURL=
http://oldserver:8080&sourceAdmin=user&sourcePassword=pwd"
http://localhost.mycompany.com:8080/review/api
Typically these operations are scripted using a language such as Python. See the Klocwork Web API cookbook
for examples of scripted curl calls using Python.

Import taxonomy file(s)
If you imported a custom taxonomy, for example, MISRA, in a previous release, you need to re-import the
new taxonomy file to pick up changes. See What's new for a list of changes to the taxonomies.

Import your code reviews
You can import your existing code reviews into your new projects root.
To import your existing Klocwork Inspect code reviews:
Note: Before importing code review data, you must have the equivalent project in your local projects
root. Importing code review data will overwrite any existing code review data in the current
projects_root folder.
1. In the Klocwork Product Portal, click Code Review.
2. Click Settings, then in the left pane, click Import.
3. Click Import code reviews, then specify the URL of the source Klocwork server, the user ID of the
Klocwork administrator for the source projects root, and the password (if required).
4. Select the projects that you want to import, then click Import .
To import your existing Klocwork Code Review or Cahoots code reviews:
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Note: Klocwork Code Review does not organize code reviews by project. When you import existing
code reviews from your Code Review server, you must specify the code reviews by tag.
1. In the Klocwork Product Portal, click Code Review.
2. Click Settings, then in the left pane, click Import.
3. Click Import code reviews, then specify the URL of the source Klocwork Code Review server, the user
ID of the Klocwork administrator for the source projects root, and the password (if required).
4. Select the local project into which you want to import the code reviews.
5. In the left pane, select the tags that you want to import.
6. Click Assign to assign the tags to the selected project.
7. Click Import to import the code reviews.

Test your upgrade
Ensure that you can see your projects and builds in Klocwork Static Code Analysis.
If you installed a new license file, ensure that it was installed correctly by checking that the number of licenses
is correct.

Go live with your new installation
Once you're satisfied that your new installation is valid, and that your existing projects were imported correctly,
it's time to go live with your new installation.
If you've chosen a new and unique port number for your new installation, then you can go ahead and
communicate that information to your users.
If you'd like to reuse your existing port number (so that users don't have to update their local settings) then
you'll need to stop and restart all of your Klocwork servers, taking care to specify the existing server port
number for your new installation.

Upgrade all Desktop Analysis plug-ins
To take advantage of the latest improvements in Klocwork, we always recommend you upgrade your Desktop
Analysis plug-ins to the latest version of the product.
Your users can reinstall their Klocwork Desktop Analysis plug-ins themselves by downloading the appropriate
plug-ins from the Klocwork portal once it is up and running. See Downloading and deploying the desktop
analysis plug-ins on page 26 for instructions on how to download and deploy the plug-ins to the server.
Note: When upgrading to the Klocwork extension for Visual Studio, any analysis results data generated
from the previous version of the plug-in will be removed. Therefore, any local defect citation
information not already synchronized with the server will be lost. You can re-analyze your solution(s)
to get the analysis results with the new plug-in.

Before your first integration build analysis using Klocwork 2020.3
New releases of Klocwork normally have changes to the checker configuration to keep up with current events
and respond to customer requests. These changes may mean that your checker configuration from the
previous release isn't the same in the new release.
Make sure that you have the right checkers enabled to match your old configuration. See What's New for a
list of updated checkers, then make any changes to your checker configuration. After you're satisfied with
your configuration, re-generate your build specification to capture the latest changes and perform your
integration build analysis on unmodified source code.
Note: If you've already run your first Klocwork 2020.3 analysis and you're missing some issues or
status changes, delete that build, reconfigure your checkers, and run a new analysis.
We recommend running your final pre-upgrade integration build analysis and your first Klocwork 2020.3
analysis on identical source code, and then comparing the two builds. This allows you to assess changes in
the analysis engine. For details on improved, added, and removed checkers in this version, see What's New.
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Migrate your projects_root directory
You can migrate your projects_root directory and configuration settings over to your new Klocwork installation
by using the kwservice --migrate command. Typically, this process involves:
•
•
•
•

stopping your server and backing up your existing projects root folder and configuration settings
installing the new Klocwork server package by specifying the existing projects root folder, server, and
port settings
re-validating your database
testing your installation

Before you begin
We recommend that you make a copy of your projects_root directory and migrate the copy. This way,
users can continue to use Klocwork Static Code Analysis, though they should be instructed not to make any
changes, such as changing an issue's status.
To reduce the amount of time required for migration, we also strongly recommend that you delete
unneeded projects and failed builds before migration, as detailed in the procedure that follows.
If you are moving to a new major release of the software, ensure that you have a compatible license, as each
major release requires a new Klocwork license. See Licensing for more information.
If you do not use the default server settings, you will need to specify your custom settings prior to beginning
the upgrade. Otherwise, during the installation these settings will revert back to the default settings. If you
forget, you can always go in and change the settings for each of your environments after you have completed
upgrading.
To avoid losing issues, status changes or comments from the last release in your first Klocwork 2020.3 analysis
run, make sure you read Before your first Klocwork 2020.3 integration build analysis.
Tomcat server configuration: Klocwork Static Code Analysis's Tomcat server configuration
(<projects_root>/tomcat/conf/server.template) will be backed up and replaced during migration. The backup
file will be named server.template.bak or server.template.bak_X (where X is a number). If your server.template
had modifications from the Klocwork Static Code Analysis defaults, you can copy them from the backup,
ensuring that maxPostSize is set to -1, and re-start the Klocwork Static Code Analysis server.
Supported upgrade paths
Find your current version in the chart below and follow the appropriate upgrade path. If you need to upgrade
from earlier versions of the product that aren't listed in the table below, use the import method. See Import
your existing projects into a new projects_root for more information.
Rogue Wave is also here to help! If you need to move from an older release, you can contact Static Code
Analysis Professional Services to discuss assistance via a services engagement.
If you're using Klocwork version

Then follow this upgrade path

2020.2 latest

Klocwork 2020.3 latest

2020.1 latest

Klocwork 2020.3 latest

2019.3 latest

Klocwork 2020.3 latest

2019.2 latest

Klocwork 2020.3 latest

2019.1 latest

Klocwork 2020.3 latest

2019 latest

Klocwork 2020.3 latest

2018.3 latest

Klocwork 2020.1 latest --> 2020.3 latest

Interoperability between releases
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To take advantage of the latest improvements in Klocwork, we always recommend you upgrade your Server,
Build, and Desktop Analysis plug-ins to the latest version of the product. Klocwork Server and Build Tools are
compatible with the Desktop Analysis plug-ins within each major release.
Klocwork also provides the ability to load builds from the previous major version of Klocwork into the current
version of Klocwork. For example, this means you can load Klocwork builds from any version of Klocwork
2019 into Klocwork 2020.3 without having to import or migrate data. For more information, see Cross-version
support for builds.
Running two versions of the Klocwork Servers
If you will be running two sets of the Klocwork Servers, for example to test the Klocwork 2020.3 Servers while
users continue to access your existing servers, you must run them on different projects_root directories (and
set the ports appropriately).

Prepare to upgrade
For details on starting and stopping the servers, see Starting the Klocwork Servers and Stopping the Klocwork
Servers.
To prepare to upgrade:
1. For the projects_root you want to migrate, run the following command:
kwservice --projects-root <projects_root> check
2. Make note of what servers are running and what ports they are running on. After migration to the new
version of Klocwork, the servers will be running on these ports.
3. Stop the servers.
4. To create a restore point, perform a complete backup of any projects_root directories you want to migrate.
After you upgrade Klocwork, you cannot undo the upgrade. For information, see Backing up Klocwork
data.
5. If you customized any configuration files (such as kwmysql.ini or kwfilter.conf), back up the
<server_install>/config directory.
6. Start the servers.
7. IMPORTANT: To reduce the time required to migrate your Klocwork data, we strongly recommend that
you:
•
•

Delete any projects from the previous version that you do not need to migrate. See kwadmin
delete-project.
Delete any failed project builds from the previous version. You cannot resume a build that failed in
a previous release after migrating the project as described in this article. However, you may be able
to load the build from tables. See kwadmin delete-build.

8. Stop the servers.
9. (Optional) To create a second restore point, back up the projects_root directories you have prepared for
migration.
10. Store the existing Klocwork license in a safe place.
11. To prevent confusion, delete the old Klocwork logs from <projects_root>/logs.

Install the Klocwork Server package
Install the Klocwork 2020.3 Server package. For instructions, see Installing Klocwork.

Validate your database (mandatory)
dbvalidate is a tool that checks the consistency of data in your database. Running this tool is mandatory, so
that any errors in your database can be corrected before you migrate or import. Use the version of the
dbvalidate tool that matches your installed version of software (that is, the version that matches your
projects_root directory).
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Note: The Database Server from your old installation must be running to validate the database. The
Database Server is listed as a separate service from the Klocwork Server, so ensure that it is running.
Run the following command, for example:
java -jar <server_install>/class/dbvalidate.jar --projects-root <projects_root>
where
•
•

<server_install> is your installation directory
<projects_root> specifies the location of the old projects root you want to validate

Example
java -jar /local/tools/klocwork/server/class/dbvalidate.jar --projects-root
/local/tools/klocwork/server/projects_root
The dbvalidate tool will report any errors between the "validation started" and "validation finished" lines:
Wed Jun 01 07:53:58 CDT 2018 kw_central database (version: 95) validation started
<detected errors appear here>
Wed Jun 01 07:54:28 CDT 2018 Database validation finished.
•
•

If Errors are displayed, please open a support ticket so that we can correct the error prior to import or
migration.
If no errors are displayed, your database was successfully validated.

You can also run dbvalidate with the --rebuildIndex=true option; This enables you to re-create the lucene
index for the specified project, which often allows you to decrease the size of the index.
Important: Make sure you back up your lucene index folder before running dbvalidate with the
--rebuildIndex=true option.
For example, you can run the following:
java -cp dbvalidate.jar com.klocwork.dbvalidate.Cleanup203 --projects-root
<projects_root_folder> --project <project_name> --rebuildIndex=true

Put your new license in the correct directory
If you received a new license file from Customer Support, copy it to <projects_root>/licenses.
Note: See Customizing licensing for information on licensing options.

Migrate your Klocwork data
To migrate a projects_root, run the following command from <Klocwork_2020.3_Server_install>/bin:
kwservice --projects-root <old_projects_root> start --migrate
If the projects_root migrates successfully, the Klocwork Servers start on the port numbers picked up from
the migrated projects_root.
Notes:
•
•

If you imported a custom taxonomy, for example, MISRA, in a previous release, you need to re-import
the new taxonomy file to pick up changes. See What's new for a list of changes to the taxonomies.
If you will be running the Klocwork Servers as Windows services, after starting the servers with the
--migrate option, stop the servers with kwservice --projects-root <migrated_projects_root>
stop. Then start the Klocwork 2020.3 services in Windows Services Administration.
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•
•

You can manage the Klocwork servers remotely on Unix with SSH, or on Windows with Windows Services
administration. Otherwise, you must issue the start, restart, and stop commands locally.
The above command converts all external configuration files in the projects_root to UTF-8. All external
configuration files must be UTF-8 encoded if they contain multibyte characters (for example, Japanese).
External configuration files are those listed in Configuration files you can edit.

If you customized configuration or metrics files
•

If you modified the MariaDB configuration file located at
<old_Klocwork_install>/config/kwmysql.ini, make the same changes to kwmysql.ini in the
new installation.
Important: Do not copy your customized configuration files into the new Klocwork installation.
Instead, make the same customizations to the newly installed configuration files.

•

If you modified the compiler mapping file located at
<old_Klocwork_install>/config/kwfilter.conf
Make the same changes to kwfilter.conf in the new installation.
Important: Do not copy your customized configuration files into the new Klocwork installation.
Instead, make the same customizations to the newly installed configuration files.

•

•

If you added custom metrics reports to Klocwork Static Code Analysis, you need to edit the custom
metrics report configuration file (metrics.xml). The metrics.xml file is located at:
<projects_root>/config
If you are running Windows in a 32-bit environment and you modified the memory allocation file located
at <old_Klocwork_install>/config/java_wrappers_memory.conf, verify that you still need these
modifications, and make the same changes to java_wrappers_memory.conf in the new installation.

Notes
•

•

The metrics.xml file applies to a projects_root directory, not to an entire Klocwork installation. Therefore,
if you have multiple projects_root directories, you will need to copy your customized metrics.xml file to
each of your projects_roots.
You need to restart the Klocwork Server after customizing the metrics.xml file.

Test your upgrade
Ensure that you can see your projects and builds in Klocwork Static Code Analysis.
If you installed a new license file, ensure that it was installed correctly by checking that the number of licenses
is correct.

Upgrade all Desktop Analysis plug-ins
To take advantage of the latest improvements in Klocwork, we always recommend you upgrade your Desktop
Analysis plug-ins to the latest version of the product.
Your users can reinstall their Klocwork Desktop Analysis plug-ins themselves by downloading the appropriate
plug-ins from the Klocwork portal once it is up and running. See Downloading and deploying the desktop
analysis plug-ins on page 26 for instructions on how to download and deploy the plug-ins to the server.
Note: When upgrading to the Klocwork extension for Visual Studio, any analysis results data generated
from the previous version of the plug-in will be removed. Therefore, any local defect citation
information not already synchronized with the server will be lost. You can re-analyze your solution(s)
to get the analysis results with the new plug-in.

Repeat upgrade steps on other projects_root directories
To migrate another projects_root, carry out the steps in this chapter again (except for installing Klocwork).
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Summary of upgrade steps for second or later projects_root directory:
1. Prepare to upgrade.
2. Run:
kwservice --projects-root <projects_root> start --migrate
3. Re-create any compiler configuration files you had customized.
4. If you added custom metrics reports to Klocwork Static Code Analysis, edit the custom metrics report
configuration file (metrics.xml).
5. Test your upgrade.

Before your first integration build analysis using Klocwork 2020.3
New releases of Klocwork normally have changes to the checker configuration to keep up with current events
and respond to customer requests. These changes may mean that your checker configuration from the
previous release isn't the same in the new release.
Make sure that you have the right checkers enabled to match your old configuration. See What's New for a
list of updated checkers, then make any changes to your checker configuration. After you're satisfied with
your configuration, re-generate your build specification to capture the latest changes and perform your
integration build analysis on unmodified source code.
Note: If you've already run your first Klocwork 2020.3 analysis and you're missing some issues or
status changes, delete that build, reconfigure your checkers, and run a new analysis.
We recommend running your final pre-upgrade integration build analysis and your first Klocwork 2020.3
analysis on identical source code, and then comparing the two builds. This allows you to assess changes in
the analysis engine. For details on improved, added, and removed checkers in this version, see What's New.
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Installing Klocwork
Follow the steps described below to install the Klocwork Server, build tools, and desktop analysis plug-ins.
For help, see Troubleshooting your installation on page 40 below.

Solaris and AIX support
Downloads for Solaris and AIX are now by request. To obtain Solaris or AIX product downloads, please contact
Klocwork Customer Support.
Solaris installation packages, build tools, and desktop tools are available for Klocwork release 2020.1. Downloads
are not available for later releases.

Installing the Klocwork Server package on Windows
This page provides instructions for installing the Klocwork Server package using the installation wizard. For
instructions on unattended installation of both the Klocwork Server and desktop analysis plugins, see
Unattended installation on Windows.
Your users can install the desktop analysis plug-ins from the product portal ("pull" installation) or, if your
organization is set up for it, you can install the clients for your users in an unattended ("push") installation
through a Software Management System (SMS) or similar system.

Before you begin
Upgrading? See Upgrading from a previous version.
Where do I get the software?
Download the packages from Klocwork Support. Typically, only one or two users in an organization have
access to the Klocwork technical support portal. If you don't have access, you can register for a new account.
You need a license. See Getting a license if you don't already have one.
Running two versions of the Klocwork Servers
If you will be running two sets of the Klocwork Servers, for example to test the Klocwork 2020.3 Servers while
users continue to access your existing servers, you must run them on different projects_root directories (and
set the ports appropriately).
Required permissions
•
•
•

Administrator access is required to install all Windows packages, whether using the installation wizard
or unattended installation.
You must have administrator access to install the Klocwork Server.
You must have administrator permissions to start the Klocwork Servers (and to run the Klocwork Servers
as Windows Services).

Installation using the Windows installation wizard
Run the Klocwork Server installation wizard, following the prompts. Note the following:
•
•
•
•

During installation, one or more Visual C++ Runtime redistributable packages may be installed on your
computer. Depending on your operating system, a reboot may be required at the end of the installation.
The installation package automatically detects whether you have a 32-bit or 64-bit operating system and
installs the appropriate JVM.
If your system locale is Japanese, the installation package runs in Japanese. Otherwise, it runs in English.
In the Setup Type dialog, you can choose a complete or custom installation. The complete option
installs all program features, and is the typical installation. If you choose custom, you can choose a
Klocwork Servers Only option. The Klocwork Servers and Build Tools option is the same as the
complete installation.
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•

You'll be asked where you want to create the projects_root directory, which is the data location for the
Klocwork Servers and applications. It contains Klocwork Server settings and information about integration
projects and build analysis runs. It also stores the Klocwork license file. The default location is
<server_install>\projects_root.
Caution: Do not install the Server package and the projects_root directory in the Program Files
directory. Default security settings for Windows and Windows Server restrict writing to files in
the Program Files directory.

•

•

•
•

You can specify server port information during installation in the Set up Klocwork servers dialog to
override the default settings. See Viewing and changing Klocwork server settings for more information
about ports.
During installation, you specify whether you want to use the locally installed License Server (Local) or
connect to a remote License Server (Remote). Local, the default option, requires you to browse to your
license file. If you select Remote, you must specify the host name and port number for your License
Server.
You also have the option of starting the Klocwork Servers as Windows services automatically following
installation. If you do not select this option, you need to start the servers manually following installation.
For information about setting up a secure connection to the Klocwork Server, see Using a secure Klocwork
Server connection.

Installing the License Server on a separate host
If you want to install the License Server on a separate host from the Klocwork servers, you need to install it
from the command line by using the following command:
kw-server-installer.20.3.x.x.windows.exe /w /S /v"/qn /norestart
INSTALLDIR=<local_directory> ADDLOCAL=LicenseServer,JRE"
where:
•

<local_directory> specifies the directory in which you want to install the License Server.

Note on the Path environment variable
On Windows, the Klocwork bin directory is automatically added to your Path environment variable as follows:
Installation package

Environment variable Value used
modified

Server

System Path

<server_install>\bin

Desktop Analysis Tools

System Path

<desktop_analysis_tool_install>\bin

Log files for Windows installation
An installation log file is saved to the Temp directory of Local Settings whenever one of the Klocwork installation
packages is started on Windows. For example, on Windows 10, the installation log file is saved to
%LOCALAPPDATA%\Local\Temp.
These log files are named Klocwork<release>-<package>.log . For example, the installation log file for
the Klocwork 2020.3 Server package is named Klocwork2020.3-Server.log.
A logs directory is also created in the root Klocwork installation directory during installation. For the Server
installer, for example, the log files in this directory store kwservice output when the servers are first started
and the projects_root directory is initialized.
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Start the servers
To start the servers, use Windows Services Administration or kwservice start:
kwservice --projects-root <projects_root> start
where <projects_root> is the projects_root directory you specified during installation
Example
kwservice --projects-root C:\klocwork\projects_root start

Log in to Klocwork Static Code Analysis
After starting the Klocwork servers, Klocwork Static Code Analysis is accessible from a browser using the URL
of the Klocwork server hostname and the Klocwork server port chosen during the install (for example,
server21:8080). By default, the person who installed Klocwork is set as the Klocwork administrator, and is
given the Projects root admin role. Initially, the Basic Authentication access control method is used, so no
password is needed to log in. For example, if the user account used during the installation was ‘jsmith’, to log
in to Static Code Analysis with the administrator role, use the credentials:
username: jsmith
password: <empty>
For more details on security and authentication methods, see Security and permissions.

Installing the Klocwork Server package on Windows -- Upgrade only
This page provides instructions for installing the Server package if you are upgrading.
IMPORTANT: This is not the starting point for upgrading. Make sure you start with Upgrading from a previous
version.

Before you begin
Where do I get the software?
Download the packages from Klocwork Support. Typically, only one or two users in an organization have
access to the Klocwork technical support portal. If you don't have access, you can register for a new account.
Required permissions
•
•
•

Administrator access is required to install all Windows packages, whether using the installation wizard
or unattended installation.
You must have administrator access to install the Klocwork Server.
You must have administrator permissions to start the Klocwork Servers (and to run the Klocwork Servers
as Windows Services).

Run the installation wizard
Run the Klocwork Server installation wizard, following the prompts. Note the following:
•
•
•
•
•

The installation package includes a pre-packaged JVM and automatically detect whether you have a 32-bit
or 64-bit operating system.
If your system locale is Japanese, the installation package runs in Japanese. Otherwise, it runs in English.
Caution: Do not install the Server package and the projects_root in the Program Files directory. Default
security settings for Windows Server restrict writing to files in the Program Files directory.
For information on the Use secure server connection (HTTPS) checkbox, see Using a secure Klocwork Server
connection.
When prompted for the location of the projects_root directory, specify the old projects_root directory
that you want to migrate.
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•
•
•
•

You do not need to set host names and port numbers for the Klocwork Servers during installation. This
information will be picked up from your old projects_root directory when it is migrated.
Do not select the option to start the Klocwork Servers as Windows services automatically. You will start
the servers in a later step.
The Klocwork bin directory (<server_install>\bin) is automatically added to your System Path
environment variable.
The Klocwork Server and Database Server need to be running on the same machine.

Log files
An installation log file is saved to the Temp directory of Local Settings whenever one of the Klocwork installation
packages is started on Windows, at, for example, \Users\<user>\AppData\Local\Temp.
These log files are named Klocwork<release_number>-<package>.log . For example, the installation
log file for the Klocwork 2020.3 Server package is named Klocwork20.3-Server.log.
A logs directory is also created in the root Klocwork installation directory during installation. For the Server
installer, for example, the log files in this directory store kwservice output when the servers are first started
and the projects_root directory is initialized.

Installing the Klocwork Server package on Linux
This page provides instructions for installing the Klocwork Server package using the installer.

Before you begin
Upgrading? See Upgrading from a previous version.
Where do I get the software?
Download the packages from Klocwork Support. Typically, only one or two users in an organization have
access to the Klocwork technical support portal. If you don't have access, you can register for a new account.
You need a license. See Get a license if you don't already have one.
Running two versions of the Klocwork Servers
If you will be running two sets of the Klocwork Servers, for example to test the Klocwork 2020.3 Servers while
users continue to access your existing servers, you must run them on different projects_root directories.
Check the system requirements
Refer to the System requirements for a list of required packages and dependencies.
Installation notes
•
•
•
•
•
•

•
•

Linux only: There are separate installation packages for 32-bit and 64-bit Java. Make sure you select the
one that matches your operating system.
ulimit -n must be 2048 in order to run the Klocwork Server.
Ensure that the downloaded .sh file is executable. Use the chmod command to set the appropriate
permissions:chmod 755 <kw-installer.sh>
To control permissions when you are installing Klocwork, change the value of umask.
Install Klocwork software as a non-root user.
Ensure that the path in which you install the product is the same path from which users invoke the
product. For example, the local path to the installation might be /local/tools/klocwork, but users
on other machines have to use the NFS path /opt/tools/klocwork to invoke the product. Therefore,
to ensure that users can invoke the product, use the /opt/tools/klocwork path during installation.
Due to issues with file locking, user home directories should not be located on NFS. See Failed to lock
file or directory: No locks available.
For some Linux installations, if you want to run the Klocwork Server, you may be required to install
additional third-party libraries. For example: libaio1, libaio, or libaio.x86_64.
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•
•
•

For AIX and Solaris, the Klocwork Server must be run from a separate Linux machine. For more information,
see .
If you are installing on 64-bit Linux and the target machine has 6 GB or more of memory, the memory
settings configuration will be increased to improve performance.
The Klocwork Server and Database Server need to be running on the same machine.
Note: Do not locate the projects_root directory on NFS to avoid issues with file locking.

Running the installation package
Run the following command:
kw-server-installer.20.3.x.x.<platform>.sh [options] <install_directory> [<component
...>]
where
•
•
•

•

<platform> is linux.
[<options>] are any of the options listed in Command-line options for the Server package.
<install_directory> specifies the directory in which you want to install Klocwork. Do not specify a
subdirectory of the projects_root directory. Note that if the chosen directory is not empty, you will not
be able to continue with the installation.
[<component ...>] is any of the arguments from Arguments for Server components. Separate multiple
components with spaces. If you do not specify one or more components, the entire package will be
installed. You can also see a list of arguments for the various components with the --list option.

Command-line options for the Server package
Name

Short name

Description

--agree

-a

Agree to license terms and do not display license
agreement.

--database-port <port_number>

Specify the port number that you will use to run the
Database Server. Default: 3306. This option is
equivalent to specifying the port number with
kwservice.

--debug

Print debug information

--force

-f

Install without integrity checks

--help

-h

Display this help and exit

--klocwork-port <port_number>

Specify the port number that you will use to run the
Klocwork Server. Default: 8080. This option is
equivalent to specifying the port number with
kwservice.

--license-port <port_number>

Specify that the License Server will be run locally, but
on a non-default port. Default: 27000. This option is
equivalent to specifying the port number with
kwservice.

--license-server <host>[:<port>]

Specify a remote License Server host. The host
argument is required; the port argument is optional.
Default: localhost:27000. This option is equivalent to
specifying the host and port with kwservice. See also
Using your organization's FlexNet Publisher server.

--list
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-l

List available features (components)

Name

Short name

Description

--projects-root <directory>

-p

Specify the complete path to a non-default
projects_root directory. Default:
<install_directory>/projects_root. The
directory you specify must meet one of the following
conditions:
•
•
•

it does not yet exist
it is empty
it is a valid projects_root directory created
previously. Do not specify the same directory as
the root Klocwork installation directory you have
specified. Do not install Klocwork in a subdirectory
of the projects_root directory.

IMPORTANT: If you are upgrading, specify the old
projects_root directory that you want to migrate.
--version

-v

display the version of Klocwork software and exit

Arguments for Server components
To install this Server component (feature)...

...enter the argument...

License Server

LicenseServer

Klocwork Server

KlocworkServer

Administration and analysis management tools

BuildTools

Add Klocwork to your PATH
On Linux, we recommend adding <klocwork_install>/bin to your PATH. Otherwise, you need to execute
commands from <klocwork_install>/bin.

Copy the license file
Copy your license file to the following location:
<projects_root>/licenses
The license file must have the extension .lic.
Note: See Customizing licensing for licensing options such as using your organization's license
server.

Start the servers
Start the servers with kwservice start:
kwservice --projects-root <projects_root> start
where <projects_root> is the projects_root directory you specified during installation
Example
kwservice --projects-root /space/klocwork/projects_root start
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You see messages indicating that the servers have been started, showing the server host name and port
number and the path to the projects_root. For example:
Using projects root: /space/klocwork/projects_root Local
[13.1.1.142]
Starting License Server [started on serverxyz.com:27000]
/space/klocwork/projects_root)
Starting Database Server [started on serverxyz.com:3306]
/space/klocwork/projects_root)
Starting Klocwork Server [started on serverxyz.com:8080]
/space/klocwork/projects_root)

Host is: serverxyz.com
(projects root is
(projects root is
(projects root is

Important: If you create a script to start the Klocwork servers automatically, do not name your
script 'klocwork' as it will interfere with existing processes.

Log in to Klocwork Static Code Analysis
After starting the Klocwork servers, Klocwork Static Code Analysis is accessible from a browser using the URL
of the Klocwork server hostname and the Klocwork server port chosen during the install (for example,
server21:8080). By default, the person who installed Klocwork is set as the Klocwork administrator, and is
given the Projects root admin role. Initially, the Basic Authentication access control method is used, so no
password is needed to log in. For example, if the user account used during the installation was ‘jsmith’, to log
in to Static Code Analysis with the administrator role, use the credentials:
username: jsmith
password: <empty>
For more details on security and authentication methods, see Security and permissions.

Installing the Klocwork Server package on Linux -- Upgrade only
This page provides instructions for installing the Server package if you are upgrading.
Important: This is not the starting point for upgrading. Make sure you start with Upgrading from
a previous version.

Before you begin
Where do I get the software?
Download the packages from Klocwork Support Typically, only one or two users in an organization have access
to Klocwork Developer Network. If you don't have access, you can register for a new account.
Installation notes
•
•
•
•
•
•

•

Linux only: There are separate installation packages for 32-bit and 64-bit Java. Make sure you select the
one that matches your operating system.
ulimit —n must be 2048 in order to run the Klocwork Server.
Ensure that the downloaded .sh file is executable. Use the chmod command to set the appropriate
permissions:chmod 755 <kw-installer.sh>
To control permissions when you are installing Klocwork, change the value of umask.
Install Klocwork software as a non-root user.
Ensure that the path in which you install the product is the same path from which users invoke the
product. For example, the local path to the installation might be /local/tools/klocwork, but users
on other machines have to use the NFS path /opt/tools/klocwork to invoke the product. Therefore,
to ensure that users can invoke the product, use the /opt/tools/klocwork path during installation.
Due to issues with file locking, user home directories should not be located on NFS. See Failed to lock
file or directory: No locks available.
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•

The Klocwork Server and Database Server need to be running on the same machine.
Note: Do not locate the projects_root directory on NFS to avoid issues with file locking.

Run the installation package
Run the following command:
kw-server-installer-20.3.x.x.<platform>.sh -p <projects_root> [options]
<install_directory> [component ...]
where
•
•
•

<platform> is linux.
<projects_root> is the location of the old projects_root directory that you want to migrate
[<options>] are any of the options listed in Command-line options for the Server package
Note: You do not need to set host names and port numbers for the Klocwork Servers during
installation. This information will be picked up from your old projects_root directory when it is
migrated.

•

•

<install_directory> specifies the directory in which you want to install Klocwork. Do not specify a
subdirectory of the projects_root directory. Note that if the chosen directory is not empty, you will not
be able to continue with the installation.
[<component ...>] is any of the arguments from Arguments for Server components. Separate multiple
components with spaces. If you do not specify one or more components, the entire package will be
installed. You can also see a list of arguments for the various components with the --list option. Note
that an asterisk in the returned output means the component is already installed.

Example
kw-server-installer-20.3.0.0.linux.sh -p /space/old_projects_root /opt/klocwork

Command-line options for the Server package
Name

Short name

Description

--agree

-a

Agree to license terms and do not display license
agreement.

--database-port <port_number>

Specify the port number that you will use to run the
Database Server. Default: 3306. This option is equivalent
to specifying the port number with kwservice.

--debug

Print debug information

--force

-f

Install without integrity checks

--help

-h

Display this help and exit

--klocwork-port <port_number>

Specify the port number that you will use to run the
Klocwork Server. Default: 8080. This option is equivalent to
specifying the port number with kwservice.

--license-port <port_number>

Specify that the License Server will be run locally, but on a
non-default port. Default: 27000. This option is equivalent
to specifying the port number with kwservice.

--license-server <host>[:<port>]

Specify a remote License Server host. The host argument
is required; the port argument is optional. Default:
localhost:27000. This option is equivalent to specifying the
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Name

Short name

Description
host and port with kwservice. See also Using your
organization's FlexNet Publisher server.

--list

-l

List available features (components)

--projects-root <directory>

-p

Specify the complete path to a non-default projects_root
directory. Default:
<install_directory>/projects_root. The directory
you specify must meet one of the following conditions:
•
•
•

it does not yet exist
it is empty
it is a valid projects_root directory created previously
Do not specify the same directory as the root Klocwork
installation directory you have specified. Do not install
Klocwork in a subdirectory of the projects_root
directory.

IMPORTANT: If you are upgrading, specify the old
projects_root directory that you want to migrate.
--version

-v

display the version of Klocwork software and exit

Arguments for Server components
To install this Server component (feature)...

...enter the argument...

License Server

LicenseServer

Klocwork Server

KlocworkServer

Administration and analysis management tools

BuildTools

Add Klocwork to your PATH
On Linux, we recommend adding <klocwork_install>/bin to your PATH. Otherwise, you need to execute
commands from <klocwork_install>/bin.

Installing the Build Tools package
What is the Build Tools package?
The kwbuildtools package is a zip archive which contains the following components:
•
•
•

The build integration tools (kwinject, kwant)
The analysis engine
Tools required to interact with the remote server (kwauth, kwadmin, kwdeploy, kwbuildproject)

The following platforms are supported for the kwbuildtools package: Supported platforms

How to install the Build Tools package
Prerequisite: The Build Tools package requires access to a Klocwork Server for configuration information
and to publish results; The Server may be local or remote. If you are on Mac, AIX, or Solaris, you must have
your Klocwork Server running remotely from a Windows or Linux machine.
1. Unzip the kwbuildtools.<version>.<platform>.zip to your desired location on your local machine.
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2. Run kwdeploy to sync any custom checkers and/or compiler filter files you have deployed on the Klocwork
Server. Note that you need to re-run kwdeploy whenever new files are deployed on the server. For
example:
kwdeploy sync --url http(s)://<host>:<port>

Installing the Build Tools package -- Upgrade only
If you are upgrading to a new version of Klocwork, you need to upgrade the version of the Build Tools package
you are using as well. Below is our recommended procedure for upgrading this package.

Perform the upgrade
1. Install the latest Klocwork Server package on your Windows or Linux server. For more details on this,
see Installing Klocwork on page 16.
2. Download and unzip the latest version of the Build Tools package to a new directory.
Note: Back up any configuration files you do not have synched to the Klocwork Server, as these
are overwritten when you unzip the latest Build Tools package on top of the old one.

Installing the continuous integration (kwciagent) package
What is the continuous integration (kwciagent) package?
kwciagent is a continuous integration (CI) analysis tool for C/C++, C#, and Java developers similar to kwcheck.
Whereas kwcheck is used on developer's desktops, kwciagent can be used on CI systems to analyze changed
code.

How to install the kwciagent package
Prerequisite: The kwciagent package requires access to a Klocwork Server for configuration information and
optimal analysis results. The Server can be local or remote. If you are on Mac, AIX, or Solaris, you must have
your Klocwork Server running remotely from a Windows or Linux machine.
•

Unzip the kwciagent.<version>.<platform>.zip to the desired location on your local machine.
Note: If you also have the Build Tools package installed, make sure they are in different locations
as some files are similar and may be overwritten.

Klocwork Server Configuration for Mac/AIX/Solaris
Changes in Klocwork 2019
As of Klocwork 2019, we no longer provide a Server package for Mac, AIX, or Solaris. You can still analyze your
applications on these platforms and load the results to a remote Klocwork Server.

Installing the Build Tools package (all platforms)
Once you have configured the Klocwork Server on your remote Windows or Linux host, you need to unzip
the Build Tools package onto each host where you want to analyze locally. For more information about this,
see Installing the Build Tools package on page 24.
After you've installed the Server and the Build Tools package, run kwdeploy sync to synchronize your build
environment. Also, if you have any custom scripts and the server location has changed, ensure these files
have been updated to point to the new server location.
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Downloading and deploying the desktop analysis plug-ins
The desktop analysis tools refer to the desktop analysis plug-ins and the Klocwork Command Line tools.
As Klocwork Administrator, you can download the desktop analysis tools from
https://library.roguewave.com/display/SUPPORT/Klocwork+-+Product+Downloads (see Desktop Tools
Packages), unzip them, and place them within the clients directory of the Klocwork Server installation. This
will allow your users to download a desktop analysis tool directly from the portal. Once downloaded, your
users can easily install a desktop analysis plug-in on their own.
Depending on your corporate IT policies, you may decide to install the Klocwork desktop analysis tools yourself,
as part of a controlled rollout. If this is the case, follow the steps below to download the Klocwork Desktop
tools, then see the installation instructions for details on how to install the plug-ins on your user's desktops.
The Klocwork Desktop Tools packages are organized by platform, where each archive contains the plug-ins
supported for the respective platform.
Package

Platform

kw-desktop-tools.20.3.x.xxx.windows.zip

Windows

kw-desktop-tools.20.3.x.xxx.mac.zip

Mac

kw-desktop-tools.20.3.x.xxx.linux.zip

Linux

kw-desktop-tools.20.3.x.xxx.solaris.zip

Solaris

Note: the xxx portion of the path indicates the minor build number.
To deploy the Klocwork Desktop tools:
1. Download the applicable Klocwork Desktop tools package from Support downloads.
You'll need to log in to the site using your Rogue Wave Support Center user ID and password. If you do
not currently have a Rogue Wave Support Center user ID and password, you'll need to register as a new
user. You need to have active maintenance to access this page.
2. Once downloaded, unzip the Desktop Tools package archive into the <server_install_path>/clients
directory, where <server_install_path> is the location of your Klocwork Server installation on
Windows.
On Mac, the folder is located at /usr/local/kw/server/clients
or/Library/Frameworks/KlocworkServer.framework/Versions/2020.3/clients
Note: This directory contains a single file called clients.json. Do not delete this file.
3. Refresh the portal and verify that the Downloads list appears on the right hand side of the portal. The
Downloads list contains links to the desktop analysis plug-ins. Your users can download and install the
desktop analysis tools directly from here.
4. Communicate the deployment to your users, either by sending them a link to the portal and to the
installation instructions below or by sending an internal email that describes how users can download
and install the plug-ins.
To specify the Eclipse update site locally:
1. Download the Eclipse update site zip file from Support downloads.
You'll need to log in to the site using your Rogue Wave Technical Support Network user ID and password.
If you do not currently have a Rogue Wave Technical Support Network user ID and password, you'll need
to register as a new user. You need to have active maintenance to access this page.
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2. Open the <server_install_path>\clients directory and unzip the file here into a folder called
'update-site'.
3. The 'clients' directory contains a file called clients.json. Do not delete this file. Open the file in your
preferred text editor.
4. In the section of the file called 'title: "Eclipse update site"', edit the 'file:' field, to change it to the location
of the newly created 'update-site' folder. Delete the 'url:' line and save the file. Here is an example of the
updated clients.json file:

5. Refresh the portal and verify that the Eclipse update site section appears on the right hand side under
Downloads. Your users can now copy this link and install the Klocwork plug-in for Eclipse. For further
instructions on this, see Installing the Klocwork plug-in from the Eclipse update site on page 30.

Downloading and deploying additional resources to your Klocwork Portal
Klocwork provides additional resources, which administrators can download and share with users. These
resources include the integration analysis tools (Build Tools), which are required to run analysis and load
results to the Portal, the continuous integration analysis tools (CI Agent tools), and taxonomy files.
As Klocwork Administrator, you can download additional resources such as build tools and CI agent tools
from https://library.roguewave.com/display/SUPPORT/Klocwork+-+Product+Downloads and place them within
the clients directory of the Klocwork Server installation. This will allow your users to download analysis
tools directly from the portal. Once downloaded, your users can easily install these tools on their own.
The additional tools packages are organized by platform, where each archive contains the executables
supported for the respective platform. Below are the available Build Tools packages:
Package

Platform

kwbuildtools20.3.x.xxx.win32.zip

Windows (32-bit)

kwbuildtools20.3.x.xxx.win64.zip

Windows (64-bit)

kwbuildtools20.3.x.xxx.linux.zip

Linux (32-bit)

kwbuildtools20.3.x.xxx.linux64.zip

Linux (64-bit)

kwbuildtools20.3.x.xxx.aix.zip

AIX

kwbuildtools20.3.x.xxx.solaris.zip

Solaris

kwbuildtools20.3.x.xxx.mac.zip

MacOS

Below are the available CI Agent Tools packages:
Package

Platform

kwciagent20.3.x.xxx.win32.zip

Windows (32-bit)
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Package

Platform

kwciagent20.3.x.xxx.win64.zip

Windows (64-bit)

kwciagent20.3.x.xxx.linux.zip

Linux (32-bit)

kwciagent20.3.x.xxx.linux64.zip

Linux (64-bit)

Note: the xxx portion of the path indicates the minor build number.
To deploy these additional tools packages:
1. Download the applicable tools package from Support downloads.
You'll need to log in to the site using your Rogue Wave Support Center user ID and password. If you do
not currently have a Rogue Wave Support Center user ID and password, you'll need to register as a new
user. You need to have active maintenance to access this page.
2. Once downloaded, copy the additional tools packages into the <server_install_path>/clients
directory, where <server_install_path> is the location of your Klocwork Server installation on
Windows.
On Mac, the folder is located at /usr/local/kw/server/clients
or/Library/Frameworks/KlocworkServer.framework/Versions/2020.3/clients
Note: This directory contains a file called clients.json. Do not delete this file.
3. Refresh the portal and verify that the Downloads list appears on the right hand side of the portal. The
Downloads list contains links to the desktop analysis plug-ins. Your users can download and install the
Build and CI Agent tools directly from here.
4. Communicate the deployment to your users, by sending them a link to the portal and an internal email
that describes how users can download and install the plug-ins.

Packaging and deploying taxonomy files to your Klocwork Portal
Taxonomies are another downloadable artifact you can add to the Klocwork Portal and share with your users.
For example, users with Project Admin roles can import taxonomies files into their existing projects. The
method of deploying them is slightly different. To share taxonomy files, you need to do the following:
1. Locate the taxonomy files you want to package together; For example, you can package together the
taxonomy files found in the <server_install_path>/taxonomies folder and/or add your own custom
taxonomy files.
2. Zip up the taxonomy files and add them to a taxonomies.zip file. Note that if you name this file anything
else, it will not appear in the Portal as expected.
3. Once zipped up, copy the entire taxonomies.zip file into the <server_install_path>/clients
directory, where <server_install_path> is the location of your Klocwork Server installation on
Windows.
On Mac, the folder is located at /usr/local/kw/server/clients
or/Library/Frameworks/KlocworkServer.framework/Versions/2020.3/clients
Note: This directory contains a file called clients.json. Do not delete this file.
4. Refresh the portal and verify that the Downloads list appears on the right hand side of the portal. The
Downloads list contains a link to download the taxonomies.zip file. Your users can download and
copy the taxonomies.zip directly from here.
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5. Communicate the change to your users, by sending them a link to the portal and sending an internal
email that describes how users can download and install the taxonomies. Users need to unzip this file
into their <server_install_path>/taxonomies folder.

Installing a desktop analysis plug-in
After you (as Klocwork Administrator) have installed and started the Klocwork Servers, and have downloaded
and deployed the desktop analysis plug-ins to the server installation, your users can access the product portal
and download and install a desktop analysis plug-in. If your users prefer to work on the command line or
want to do a combination of both, they can install the command line tools.
Note: The Downloads section will not appear in the portal until the Klocwork Administrator has
deployed the plug-ins. See Downloading and deploying the desktop analysis plug-ins for more
information.
To install a plug-in, open the product on the machine where you've installed Klocwork. For example, go to:
http://server01:8080/portal/Portal.html

Install your plug-in
As a desktop analysis user, once you've downloaded the installation package from the server, you must run
the installer. On Windows and Mac, an installation wizard is provided to guide you through the installation
process.
Before you begin
•
•
•

•
•

You can override the default settings for the Klocwork Servers during installation. The defaults for the
License Server are localhost and 27000. The default port for the Klocwork Server is 8080.
On Windows: Avoid installing the package in the Program Files directory on Windows. Windows User
Access Control (UAC) restricts writing to the Program Files directory.
Klocwork Servers configuration screen: Specify the Klocwork Server information provided by your Klocwork
administrator. Select Use secure server connection (HTTPS) if a secure Klocwork Server connection has
been configured.
Make sure that you have the appropriate administrator access before installing the desktop plugin.
On Unix:
•
•
•
•
•

To control permissions when you are installing Klocwork, change the value of umask.
To change the permissions on an existing installation, use chmod.
Install Klocwork software as a non-root user.
Linux only: There are separate installation packages for 32-bit and 64-bit Java. Make sure you select
the one that matches your operating system.
There is no separate plug-in for Android Studio on Windows or Linux: use the IntelliJ IDEA zip package
to integrate with Android Studio.

On Windows and Mac
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For Visual Studio and our command line tools, simply download the package and run the installation wizard.
The installation wizard will guide you through the rest of the process. For IntelliJ IDEA, Android Studio, and
CLion, see Installing the CLion/IntelliJ IDEA/Android Studio plugins.
On Mac
•
•
•

JVM version: On Mac OS, Klocwork uses the Java Virtual Machine provided by your system. Klocwork
requires Java 7 or Java 8.
Files are installed in the following location:/Library/Frameworks/
Access command-line tools using the symbolic links in /usr/local/kw/.

On Unix
You can install the packages using the following command:
kw-<plug-in>-installer.sh [options] <install_directory>
Where
•
•

•

<plug-in> is the name of the plug-in you want to install. For example, 'cmd'.
[options] are any command line options you may want to specify. In most cases, just specify '-a' here to
indicate that you agree to the terms of the Klocwork license. Use --h to get help on what available
command line options exist.
<install_directory> specifies the directory where the Klocwork plug-in will be installed

Add the bin directory to your PATH
We recommend adding the <command_line_tools_install>/bin directory to your PATH environment
variable. Procedures in the documentation assume that you have added the bin directory to your PATH.
Command-line options for the desktop analysis plugin package on Unix
Name

Short name

Description

--agree

-a

agree to license terms and do not display license
agreement

--force

-f

install without integrity checks

--help

-h

display this help and exit

--klocwork-server <host>[:<port>]

specify the Klocwork Server host name and port
number. Default: localhost:8080.

--license-server <host>[:<port>]

specify the License Server host name and port number.
Default: localhost:27000

--version
--debug

-v

display the version of Klocwork software and exit
print the debug information

Example: Installing the Command Line Tools package on Linux
kw-cmd-installer.linux64.sh -a /home/jlee/klocwork
where
•
•

-a means that you agree to the terms of the Klocwork license
/home/jlee/klocwork specifies where Klocwork will be installed

Installing the Klocwork plug-in from the Eclipse update site
Prerequisite: Your Eclipse IDE must be running under JVM 1.7 or higher before installing the Klocwork plugin.
To install the Klocwork Desktop Analysis plug-in for Eclipse, follow the steps below.
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1.
2.
3.
4.

In the Klocwork product portal, under Downloads, click Eclipse update site.
Copy the URL.
Open Eclipse.
Follow the instructions according to the version of Eclipse you're using:
•
•
•

For Eclipse 3.4, go to Help > Software Updates.
For Eclipse 3.5 or newer, go to Help > Install New Software.
For Wind River Workbench prior to version 4.0, select the Advanced Device Development
perspective (the button near the upper right) to access Help > Software Updates.

5. In the Install dialog, paste the URL into the Work with: field and press Enter.
6. Select the Klocwork Tools check box.
7. If you use Wind River Workbench, click the arrow next to the Wind River Workbench Integrations check
box and then select the appropriate Klocwork Wind River Workbench Integration:
•
•

Select the Klocwork Wind River Workbench 3 Integration check box for Wind River version 3.
Select the Klocwork Wind River Workbench 4 Integration check box for Wind River version 4.

8. Click Next and the wizard will guide you through the rest of the installation process.
9. When you are prompted to restart Eclipse, click Yes.
10. Specify the information for your License Server. Go to the Settings dialog (Window > Preferences >
Klocwork > Settings). Enter your License Server and Port information, then click Apply and Close.

Installing the IntelliJ IDEA/Android Studio/CLion plugins
Important: If you have a Klocwork 2020.1 or earlier version of these plugins installed, we recommend
that you uninstall them before installing the latest version.
To install the Klocwork Desktop Analysis plugin(s) for IntelliJ IDEA, Android Studio, and/or CLion:
1. Download the applicable Klocwork Desktop tools package (kw-desktop-tools.<version>.<platform>.zip)
from Support downloads.
You'll need to log in to the site using your Rogue Wave Support Center user ID and password. If you do
not currently have a Rogue Wave Support Center user ID and password, you'll need to register as a new
user. You need to have active maintenance to access this page.
Note: You can download the zip package directly from the Downloads section in the Klocwork
Portal if your administrator has deployed the desktop analysis plug-ins. See Downloading and
deploying the desktop analysis plug-ins for more information.
2. Once downloaded, unzip the package into your preferred location.
3. In IntelliJ IDEA/Android Studio/CLion, click File > Settings and select Plugins.
4. Click the
icon and select Install Plugin from Disk...
5. Navigate to the downloaded zip package and select OK. The zip packages for each plugin are as follows:
Package

Applicable IDE

kw-idea-plugin.zip

IntelliJ IDEA, Android Studio

kw-clion-plugin.zip

CLion

6. The plugin (for example, 'Klocwork Static Analysis for CLion') now appears in your plugins list. Select
Restart IDE to complete the installation.
Configuring your system settings (CLion only)
Prerequisite: The Klocwork Command Line tools must be installed.
You can configure your system settings as follows:
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1.
2.
3.
4.

In CLion, click File > Settings.
Under Tools, select Klocwork System Settings.
Under Klocwork User Installation, navigate to the location of your Build Tools and click Apply.
After the Build Tools location is specified, the fields under Klocwork Server URL and Klocwork License
Server are populated automatically if they are blank. If these fields were previously defined, you need
to update them manually to the expected value(s).
Note: If you are using SSL authentication, ensure the Server URL is using 'https'.

5. Continuous Analysis is enabled by default; remove this option if you prefer to run analysis on demand.

Troubleshooting
•
•

Package Load Failure occurs in Visual Studio after I install patch
Error reading setup initialization file during installation
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Running a custom installation for new or upgraded IDEs
If after you installed Klocwork, you upgraded your IDE, you must uninstall the previous version of the plug-in.
For uninstallation information, see Uninstalling Klocwork.
After uninstalling, either:
•
•
•

re-run the Klocwork desktop analysis plug-in installer, or
install from the IntelliJ IDEA/Android Studio/CLion zip package, or
install from the Eclipse plugin from the update site in your new version of Eclipse

If you're using Visual Studio or Eclipse, a few additional upgrade steps are provided below:

Visual Studio
For the Klocwork extension for Visual Studio, verify that you've uninstalled the previous version of the extension
and its Help. Then, re-run the Microsoft Visual Studio Extension installer from the Portal.

Installing the Eclipse update site after upgrading Eclipse
Regardless of the Eclipse version you upgraded to, simply install the Eclipse plugin from the update site. See
Install the Klocwork plug-in from the Eclipse update site.
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Installing the Distributed Analysis package
The Distributed Analysis components are available as a separate Klocwork installation package (for example,
on Linux, the package is kw-dist-build-installer.20.3.x.x.linux.sh).
Where do I get the software?
Download the package from Klocwork Support. Typically, only one or two users in an organization have access
to the Klocwork technical support portal. If you don't have access, you can register for a new account.

Installing on Unix
To install the complete Klocwork Distributed Analysis package on Unix:
1. Download the Klocwork Distributed Analysis installation package for your operating system to a temporary
directory.
2. Ensure that the downloaded .sh file is executable. Use the chmod command to set the appropriate
permissions. Enter:
chmod 755 <executable-name>
Note: Install Klocwork software as a non-root user.
3. Run the executable with the options and arguments you want.
<kw-dist-analysis-installer> -a -i <install_directory>
where:
<kw-dist-analysis-installer> is the name of the installation executable
-a indicates that you accept the license agreement
<install_directory> is the absolute path to the location in which you want to install the Distributed Analysis
package

Installing on Windows
On Windows, you can use the installation wizard or perform an unattended installation.
To install the Klocwork Distributed Analysis package on Windows, you must have administrator permissions
for the machine you want to install on.
Installing Klocwork with the installation wizard
To install the Klocwork Distributed Analysis package or its components on a local machine:
1. Download the Klocwork Distributed Analysis package for Windows to a temporary directory.
2. Run the installation executable.
The graphical user interface initializes and prepares.
The Welcome screen of the wizard appears.
3. Click Next.
The License Agreement screen appears.
4. Review the license agreement, and, if you agree, click "I accept the terms of the license agreement".
5. Click Next.
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The "Destination Directory" screen appears. The default destination directory is the local drive with the
most available space. For example: D:\Klocwork\Distributed Analysis 20.3\
6. Click Next to accept the default folder or click Change... to install Klocwork in a different location.
If you click Change..., the Change Current Destination Folder screen appears. Browse to the folder where
you want to install Klocwork.
Important: Avoid installing the package in the Program Files directory on Windows machines.
Windows User Access Control (UAC) restricts writing to the Program Files directory.
7. Click OK.
8. Click Next.
The Setup Type screen appears. By default, the Complete button is selected.
9. To install the entire Klocwork Distributed Analysis package on one machine, leave the Complete button
selected and go to step 11.
10. To select one component to install on this machine, click Custom and click Next.
The Custom Setup screen appears, showing two choices.
Note: In the Windows installation wizard, the term "feature" means "component".
If there is a component you do not want to install on this machine, click the icon of the component and
click This feature will not be available. Any components you do not disable will be installed. Click off
Klocwork Distributed Analysis Server or Klocwork Distributed Analysis Agent, depending on which
component you do not wish to install.
Important: Ensure that you choose a location with enough disk space. See System requirements.
To see how much disk space is available on the machine, click Space.
11. Click Next.
The Ready to Install the Program screen appears.
12. To review or change any of your installation settings, click Back. To continue the installation with the
settings you have, click Install.
A progress bar appears while Klocwork installs. The Setup Wizard Completed screen appears.
13. Click Finish.
Running an unattended installation on Windows
To run an unattended Windows installation of the Distributed Analysis package, enter the following command:
<kw-dist-build-installer> /S/v"/qn [ADDLOCAL=<component_code>]
INSTALLDIR=<install_directory> /lv* <log_file>"
where:
•
•
•
•
•

<kw-dist-build-installer> is the name of the Windows Distributed Analysis installation executable
ADDLOCAL=<component_code> is optional and allows you to install only the Server or the Agent
component of the package
<component_code> is either DistributedAnalysisServer or DistributedAnalysisAgent
<install_directory> is the absolute path to the directory in which you want to install
/lv* <log_file> allows you to log installation errors to file (recommended). The directory you specify must
already exist. Use the absolute path to the log file.
Note: Surround any value that contains spaces with escaped quotation marks (\").
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Example:
kw-dist-build-installer.20.3.0.353.windows.exe /S /v"/qn
INSTALLDIR=\"C:\Klocwork\20.3\Distributed Analysis\"
/lvx* C:\Klocwork\dist_analysis.log"
Log files for Windows installation
An installation log file is saved to %USERPROFILE%\AppData\Local\Temp whenever one of the Klocwork
installation packages is started on Windows.
These log files are named Klocwork<release-number>-<package>.log. For example, the installation log
file for the Klocwork 2020.3 Distributed Analysis package is named Klocwork20.3-Dist.log.
A logs directory is also created in the root Klocwork installation directory during installation on Windows. For
the Server installer, for example, the log files in this directory store kwservice output when the servers are
first started and the projects_root directory is initialized.
If you need to troubleshoot your installation, check these logs.
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Unattended installation on Windows
To run an unattended installation of Klocwork, enter the following command:
start /WAIT <installer.exe> /w /S [/L<langid>] /v"/qn INSTALLDIR=<install_directory>
/log <install_log> PROPERTY=VALUE PROPERTY1=VALUE1..."
where:
•
•

<installer.exe> is the name of the installation package you want to use, for example,
kw-server-installer.20.3.0.353.windows.exe
/w parameter will cause the parent process to wait for the installation process. See the InstallShield help
library for more information on this.
Note: The %errorlevel% system variable can be used to check for installation success.

•

•
•
•

•

/L<langid> allows you to change the default language for the installation package. By default, if your
system locale is Japanese, the installation package will run in Japanese. Otherwise, it will run in English.
To specify Japanese, use /L1041.
/v passes subsequent parameters directly to the MSI engine. The entire string after /v must be surrounded
by quotation marks.
/qn runs the installer in unattended mode
<install_directory> is the absolute path to the directory in which you want to install Klocwork. The default
is the root directory of the local drive with the most available space.
%LOCAL_DRIVE%\Klocwork\<package>, where <package> can be Server or one of the desktop packages.
Note that if the chosen directory is not empty, you will not be able to continue with the installation.
PROPERTY=VALUE is any of the Allowable PROPERTY=VALUE pairs for unattended installation
Note: Surround any value that contains spaces with escaped quotation marks (\").

Example
start /WAIT kw-server-installer.20.3.0.353.windows.exe /w /S /v"/qn
INSTALLDIR=\"C:\Klocwork\Server 2020.3\" /log C:\server.log"
Installing a desktop analysis tool
You can install the desktop analysis tools using unattended installation, however you must first download
the desktop tools package from
https://library.roguewave.com/display/SUPPORT/Klocwork+-+Product+Downloads (see Desktop Tools
Packages) and unzip them into a folder on your local machine. The desktop tools package contains installation
binaries for each of the desktop tools, organized by platform. For more information see, Downloading and
deploying the desktop analysis plug-ins.
Once unzipped and placed into a directory on your local computer, run the unattended installation from the
command-line, specifying the file name of the installer for the desktop tool that you want to install. In the
following example, the IntelliJ IDEA plug-in is installed into a custom directory.
Example
start /WAIT kw-idea-installer.windows.exe /w /S /v"/qn
INSTALLDIR=\"C:\kw\idea_plugin\" /log C:\idea_install.log"
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Installing specific components in unattended mode
To install one or more specific Klocwork components (for example, to install the database server) in an
unattended installation, include ADDLOCAL=<component_arguments> in your command line, where
<component_arguments> is one or more arguments from the following tables. Multiple arguments must be
separated by commas, for example, ADDLOCAL=BuildTools,JRE.
Note: When running an unattended installation, you must always install the JRE component in order
for the other components to work.
To install this component (feature)

Enter the argument

Java Runtime Environment

JRE

License Server (Server installer package)

LicenseServer

Klocwork Server (Server installer package)

KlocworkServer

Distributed analysis server (Distributed build package) DistributedAnalysisServer
Distributed analysis agent (Distributed build package) DistributedAnalysisAgent

Allowable PROPERTY=VALUE pairs for unattended installation
Server package
PROPERTY=VALUE

Description

ADDLOCAL=<component_list>

Installs specific components only. See tables in
previous section for allowable values for this property.

INSTALLDIR=<install_directory>

Install into the directory you specify. Default: current
working directory. Note that if the chosen directory
is not empty, you will not be able to continue with the
installation.

PROJECTS_ROOT=<projects_root_directory>

Set up a projects_root directory in the directory you
specify. The default is
<Server_install>/projects_root. Specify the
complete path.
Important: If you are upgrading, specify the
old projects_root directory that you want to
migrate.

LICENSE_HOST=<host_name>

Specify License Server host name. Default: localhost

LICENSE_PORT=<port_number>

Specify License Server port number. Default: 27000

MYSQL_HOST=<host_name>

Specify Database Server host name. Default: localhost

MYSQL_PORT=<port_number>

Specify Database Server port number. Default: 3306

KWSERVER_HOST=<host_name>

Specify Klocwork Server host name. Default: localhost

KWSERVER_PORT=<port_number>

Specify Klocwork Server port number. Default: 8080

Note: The Server Installer also supports the ALLUSERS property. For details, see this MSDN article.
Desktop plugins
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Name

Description

ADDLOCAL=<component_arguments>

Installs specific components only. See tables in previous section
for allowable values for this property.

CREATE_SHORTCUTS=\"\"

Suppress creation of desktop shortcuts. Default: 1 (create
shortcuts)

IDEAINSTALLDIR= <directory>

The directory where IntelliJ IDEA is installed

INSTALLDIR=<directory>

Install into the directory you specify. Default: current working
directory. Note that if the chosen directory is not empty, you will
not be able to continue with the installation.

LICENSE_HOST=<host_name>

Use License Server running at <host_name>

LICENSE_PORT=<port_number>

Use License Server running at <port_number>

KWSERVER_HOST=<host_name>

Use Klocwork Server running at <host_name>

KWSERVER_PORT=<port_number>

Use Klocwork Server running at <port_number>
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After you install
The following topics describe post-installation activities including testing your installation, running an
unattended installation, installing the distributed analysis package, and troubleshooting.

Testing your installation
To test your Klocwork installation, you can either use the sample project 'demosthenes', or create and analyze
your own sample project.

Log in to Klocwork Static Code Analysis
After starting the Klocwork servers, Klocwork Static Code Analysis is accessible from a browser using the URL
of the Klocwork server hostname and the Klocwork server port chosen during the install (for example,
server21:8080). By default, the person who installed Klocwork is set as the Klocwork administrator, and is
given the Projects root admin role. Initially, the Basic Authentication access control method is used, so no
password is needed to log in. For example, if the user account used during the installation was ‘jsmith’, to log
in to Static Code Analysis with the administrator role, use the credentials:
username: jsmith
password: <empty>
For more details on security and authentication methods, see Security and permissions.

Using demosthenes
In <Klocwork_install>\samples, you can find the Demosthenes sample project (a sample C/C++ project).
This directory contains a sample project and a readme file that shows you how to set up some sample analyses
you can use to explore or demonstrate Klocwork.
Note: To successfully build a sample project on Unix you should have GNU make, GCC, and bash.

Create and analyze a sample project
To test your Server package installation, you can create and analyze a sample project and then view the results
of your analysis in Klocwork Static Code Analysis:
•
•
•

C/C++ integration build analysis - Cheat sheet
Java integration build analysis - Cheat sheet
C-sharp integration build analysis - Cheat sheet

Troubleshooting your installation
Need a hand with your installation? Did you have trouble installing the product? This section describes basic
installation issues and provides troubleshooting information.

Repairing a Windows installation of Klocwork
If files in the Klocwork installation were accidentally damaged or deleted, you can repair the installation.
You may discover that your Klocwork installation is damaged, for example, if you are attempting to uninstall
Klocwork and see the error message "Fatal error: Cannot uninstall".
If this occurs, click OK in the error message dialog to cancel the uninstallation, perform the following repair
procedure, and then run the uninstallation procedure again.
To repair a Klocwork installation on Windows:
1. In the Start menu, click Control Panel > Add or Remove Programs .
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The Add or Remove Programs dialog appears.
2. Select the Klocwork package you want to repair, and select Click here for support information.
The Support Info dialog for the selected Klocwork package appears.
3. Click Repair.
The installation is restored to a clean state.

Unable to start the Database Server because the path to the socket file is too long
If the path to the socket file (including separators and the name of the socket file) is greater than 107 characters,
you will be unable to start the Klocwork Database Server. The database log will indicate that this is the problem.
The socket file is located in the following directory:
<projects_root>/locks
To remedy this situation, move your projects to another projects_root with a path length of less than 68-72
characters, depending on the length of the Database Server port number (which can be 1 to 5 characters).
For help moving a projects_root, see Moving or creating additional projects_root directories.

Unable to start Klocwork Servers following Windows installation
If you see one of the following messages after installing the Klocwork Server package on Windows:
•

Error 1920. Service Klocwork 20.3 Server (Klocwork 20.3 Server) failed to start.
Verify that you have sufficient privileges to start system services.

•

Service Klocwork 20.3 License Server failed to start. See installation log for
more details.

An earlier version of the Klocwork Server and/or Klocwork License Server may be running on the port that
you specified during installation of Klocwork 2020.3. It is not possible to run two versions of a server on the
same port.
You need to set a different port number for the Klocwork Server and/or Klocwork License Server with kwservice
set-service-property, and then start the servers.

Database connection error
Note: Do not locate the projects_root directory on NFS to avoid issues with file locking.
If you see the following error:
Error occurred while connecting to database: Database connection to <database> refused: Communications
link failure due to underlying exception
Check the host name in the error message. If the host name is not a fully qualified host name that includes
the domain (for example, server1.klocwork.com), you need to set the fully qualified domain name for the
Database Server.
To do this:
1. Stop the Database Server:
kwservice --projects-root <projects_root> stop database
2. Run the following command:
kwservice --projects-root <projects_root> set-service-property database host
<fully-qualified-host-name>
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3. Start the Database Server:
kwservice --projects-root <projects_root> start database

Package Load Failure occurs in Visual Studio after I install patch
Do one of the following:
•
•

Uninstall the patch and install the last full version of the Visual Studio plug-in installer.
From the <VS_user_install>\inforceVSNET directory, run the following command:

regsvr32 IfPkgVS2005.dll

What to communicate to the team
Your team of developers, managers, build engineers(s), and administrator(s) need to know the following:
•
•
•
•
•

the URL of the Klocwork Server, so that managers and developers can access Klocwork Static Code
Analysis and Klocwork Code Review, and install their own desktop analysis plug-ins
that the URL of the Klocwork Server with "/documentation" added to it will give them all of the Klocwork
online documentation
the location of the projects_root directory (Klocwork administrators only)
the host and port of the License Server
who has permission to start and stop the Klocwork Servers, under what user ID, and, for Windows,
whether the servers must be managed as Windows Services

If anyone else needs to access the database, for example, to do backups, and you have locked the database
with a password, give the person the password. See Setting a password for the Klocwork database for more
information.
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Uninstalling Klocwork
To avoid duplicate entries in the Windows Control Panel and incorrect plug-in version numbers in your IDEs,
uninstall the current version of Klocwork before downgrading to a previous version.
Before you uninstall
If you will be modifying or uninstalling a Server package or connected desktop installation, you must stop the
Klocwork Servers first. See Stopping the Klocwork Servers.
If you are uninstalling the Server package, in addition to stopping the servers, you should also make a backup
copy of your projects_root directory and any configuration files you modified, such as kwfilter.conf). For
Linux and Windows, compiler configuration files are located in <server_install>/config. For more
information about backing up data, see Backing up Klocwork data.
While the Windows version of the Klocwork Server package won't uninstall the projects_root directory or
configuration files, it's a good idea to make a backup of these directories. For Linux systems, there is no
automated uninstall, so make sure you back up your projects_root and any other data files you want to keep
and store them outside your Server installation directory. Then you can delete the Server installation directory.
See also Repairing a Windows installation of Klocwork.
Viewing installed components or modifying your installation on Windows
Use the procedure below if you want to remove one or more Klocwork components, or if you need to check
what components are currently installed. For example, if you need to uninstall Klocwork before installing a
new version, you should check what components are currently installed before uninstalling, so that you can
install the same components for the new version.
To view installed components or partially uninstall Klocwork:
1. In the Start menu, go to Control Panel > Add or Remove Programs .
Windows: From the Control Panel window, under Programs, select Uninstall a program.
2. Scroll to and click the Server or desktop plug-in you want information on.
3. To find information about patches, make sure the Show updates checkbox is selected at the top of the
Add or Remove Programs panel.
The installed patches will be displayed under the Klocwork installation package entry.
4. Click Change.
The Welcome screen for the Modification wizard appears.
5. Click Next.
The Program Maintenance panel appears.
6. Select Modify and click Next.
7. The Custom Setup screen appears. Click through it to see what components (features) are installed.
Note: This symbol indicates a component that is installed:
8. If you are simply viewing installed components:
9. Record which components are installed.
10. Click Cancel.
11. Click Yes when asked if you are sure.
12. Click Finish.
13. If you want to uninstall certain components, or install components you did not previously install:
14. For the components you want to uninstall, click This feature will not be available.
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For the components you want to install, clickThis feature, and all subfeatures, will be installed on local hard
drive.
15. Click Next.
The Ready to Modify the Program screen appears.
16. Click Install.
The features you selected will be modified.
17. Click Finish.
Uninstalling Klocwork from a Windows machine
To remove a Klocwork software package:
1. From the Start menu, click All Programs > Klocwork 2020.3.
2. Select the uninstaller for the component that you want to uninstall.
Uninstalling in unattended mode on Windows
To run uninstallation in unattended mode from a Windows machine, enter the following command:
<installer.exe> /S /v"/qn REMOVE=ALL"
where <installer.exe> is the package you want to uninstall
An uninstallation log file will be saved to %USERPROFILE%\Local Settings\Temp. The log file is named
Klocwork<release>-<package>.log. For example, the uninstallation log file for the Klocwork 2020.3
Server package is named Klocwork20.3-Server.log.

Uninstalling on Linux
Viewing installed components on a Linux machine
If you are upgrading to a new version of Klocwork, check what components are currently installed before
uninstalling, so that you can install the same components from the new version.
To list installed components (features), run the following command:
kwupdate [option ...] --list
See kwupdate for the full list of options.
To uninstall on Linux, simply delete the Server package and/or desktop plug-in package installation directory.

Uninstalling on Mac
To uninstall, delete the following directories:
/Applications/Klocwork User 2020.3
/Library/Frameworks/Klocwork*.framework
/usr/local/kw

Uninstalling plug-ins
Eclipse
To uninstall the Klocwork plug-in from Eclipse:
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Eclipse 3.4

Eclipse 3.5 and up

1. From the Help menu, choose Help > Software
Updates > Manage Configuration.
2. The Product Configuration dialog appears.
3. Expand the items in the navigation pane until
you see the Klocwork feature.
4. Right-click the Klocwork feature and choose
Uninstall, and click Yes to confirm that you want
to disable this feature.

1. From the Help menu, choose Help > About
Eclipse"
2. Click Installation Details.
3. Select the Klocwork plug-in from the list and click
Uninstall.

When you're prompted to restart Eclipse, click Yes.
Once Eclipse restarts, the Klocwork buttons and menu items are no longer present. If you haven't uninstalled
the Klocwork desktop analysis plug-in for Eclipse, your Klocwork projects remain in their storage location.
IntelliJ IDEA/Android Studio/CLion
1. Go to File > Settings.
2. Click Plugins.
3. Click on the relevant Klocwork plugin (For example, Klocwork Static Analysis for CLion), click the down
arrow and select Uninstall.
4. Confirm you want to uninstall by selecting Yes.
5. Click Restart IDE and select Restart.
6. Your IDE will restart and the Klocwork plugin is now removed.
Note: You must restart IntelliJ IDEA/Android Studio/CLion after uninstallation, before you install
a new version of Klocwork.

Klocwork extension for Visual Studio
1.
2.
3.
4.
5.
6.

In Visual Studio, click Help > Add and Remove Help Content.
For the Klocwork Desktop Plugin, click Remove.
Click Update and then close the Help Viewer.
In Visual Studio, go to Tools > Extensions and Updates.
In the list of Installed items, find Klocwork Static Analysis and click Uninstall.
Restart Visual Studio in order for the changes to take effect.
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